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Introduction
MPLAB® Harmony v3 is a software framework consisting of compatible and interoperable modules that include
peripheral libraries (PLIBs), drivers, system services, middleware and third-party libraries. The MPLAB Code
Configurator (MCC) is a GUI-based tool that provides an easy way to enable and configure various MPLAB
Harmony v3 modules. The MCC is a plug-in for the MPLAB X Integrated Development Environment (IDE).

This document describes how to create an application on a 32-bit PIC32 microcontroller (MCU) using the MCC
with MPLAB Harmony v3 modules. This application sends a “Hello World!” string to a console running on a
computer. For this demonstration, the following MPLAB Harmony v3 modules are used and configured using
the MCC:

• Clock PLIB using the Clock manager to configure the microcontroller clock
• GPIO PLIB using the Pin manager to configure the microcontroller I/Os
• UART PLIB to configure UART peripheral as serial port
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1. Creating a "Hello World" Application
This document describes how to create a "Hello World" application on PIC32 devices using the
MPLAB Code Configurator (MCC) tool. It also covers the process which is shown in the following
sections. The following software and hardware tools are used for this demonstration:

• MPLAB X IDE v6.15
• MPLAB Code Configurator [MCC] Plugin v5.3.7
• MPLAB XC32 Compiler v4.30
• MPLAB Harmony v3 repositories:

– MPLAB Harmony v3 "dev_packs" repo v3.18.0
– MPLAB Harmony v3 "csp" repo v3.18.0

• Curiosity PIC32MZ EF 2.0 Development Board

Note: Updated versions of the above listed tools can also be used to create the applications, and
users are not restricted to use the older versions.

1.1 Creating an MPLAB Harmony v3-based Project
To create an MPLAB Harmony v3-based project, follow these steps:

1. Launch MPLAB X IDE.
2. In MPLAB X IDE, from the Menu bar select File > New Project (or click on the New Project icon).

Figure 1-1. New Project

3. In the New Project window, under Steps Navigation pane, select Choose Project.
4. In the right Choose Project property sheet, under Categories select Microchip Embedded and

under Projects select 32-bit MCC Harmony Project.
Note: If the 32-bit MCC Harmony Project is not available, install the MCC plug-in from Tools >
Plugins > Available Plugins before continuing with this demonstration.

Note: For additional information, visit MPLAB® Code Configurator Overview with MPLAB
Harmony Content.

https://www.microchip.com/mplab/mplab-x-ide
https://microchipdeveloper.com/harmony3:mcc-overview
https://www.microchip.com/mplab/compilers
https://github.com/Microchip-MPLAB-Harmony/csp
https://github.com/Microchip-MPLAB-Harmony/dev_packs
https://www.microchip.com/DevelopmentTools/ProductDetails/DM320209
https://microchipdeveloper.com/harmony3:mcc-overview
https://microchipdeveloper.com/harmony3:mcc-overview
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Figure 1-2. Creating MPLAB Harmony v3-Based Project - Choose Project

5. Click Next.
6. Under Steps Navigation pane, select Framework Selection.
7. In the right Manage Framework property sheet, for Framework Path enter C:\harmony3 (i.e., the

path to the folder in which the MPLAB Harmony v3 packages are downloaded).
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Figure 1-3. Creating MPLAB Harmony v3-Based Project - Framework Selection

Note: For this demonstration application, the following MPLAB Harmony v3 packages are
required: dev_packs and csp.
The MPLAB Harmony v3 Content Manager tool simplifies the downloading of the MPLAB
Harmony v3 packages. If these packages are not downloaded, then the user can use the MPLAB
Harmony v3 Content Manager tool to download it.

8. Click Next.
9. Under Steps Navigation pane, select Project Settings.
10. In the right Name and Location property sheet, enter these details:

– Location: Indicates the path to the root folder of the new project. All project files
are avaialbe in this folder. The project location can be any valid path, for example:
C:\Users\xxxx\HarmonyProjects\tech_brief (where, xxxx indicates the user ID).

– Folder: Indicates the name of the MPLAB X IDE folder. Enter hello_world to create a
hello_world.X folder.

– Name: Enter name of the project as hello_world_pic32mz_ef_curiosity2. This name
will be displayed in the MPLAB X IDE.

– Path: The path information will be updated automatically when users make changes to
other fields.
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Figure 1-4. Creating MPLAB Harmony v3-Based Project - Project Settings
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11. Click Next.
Note: To open a contextual help window for a detailed description of the various fields in the
Project Settings, click on the Show Visual Help button. The MPLAB MCC Harmony New Project
Wizard Help dialogue box will be displaced as shown below.



 TB3259
Creating a "Hello World" Application

 Technical Brief
© 2024 Microchip Technology Inc. and its subsidiaries

DS90003259B - 6

Figure 1-5. MPLAB MCC Harmony New Project Wizard Contextual Help

12. Under Steps Navigation pane, select Configuration Settings.
13. In the right Configuration Settings property sheet, enter these details:

– Name: Enter configuration name as pic32mz_ef_curiosity2.
– Target Device: In the item list, choose PIC32MZ2048EFM144.
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Figure 1-6. Creating MPLAB Harmony v3-Based Project - Configuration Settings

14. Click Finish to launch MCC.
Note: If MCC is not launched, from the Tools menu, select Embedded > Code Configurator v5:
Open/Close from MPLAB X IDE.

15. The MCC Content Manager property sheet is displayed, click Select MPLAB Harmony.

Figure 1-7. MCC Content Manager
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16. Click Finish to launch the MCC tool with packages.

Figure 1-8. MCC Setup

17. The MCC plug-in main window for the project will be displayed.

Figure 1-9. MCC Launch View

18. For additional information on MCC and how to create the MPLAB Harmony v3 project, visit:
MPLAB® Code Configurator Overview.

1.2 Adding and Configuring MPLAB Harmony Components
To add and configure MPLAB Harmony components using MCC, follow these steps:

1. In MPLAB X IDE, click Projct Graph and in the Plugins drop-down item list, select Clock
Configuration to launch the Clock Diagram.

https://microchipdeveloper.com/harmony3:mcc-overview
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Figure 1-10. Clock Diagram Launch

Note: The Clock Diagram window will be launched within the MCC window.
2. In the Clock Diagram window, scroll to the right and verify that the SYSCLK is set to 200 MHz.
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Figure 1-11. MPLAB Harmony V3 Clock Configurator - Clock Diagram

3. To add and configure the UART Peripheral Library follow these steps:
a. Click Resource Management (MCC), and then go to Project Resources.
b. Click on the Libraries under Device Resources, and then expand Libraries > Harmony >

Peripherals > UART, and then double-click on the UART6 to add it to the project graph.
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Figure 1-12. MCC Device Resources

4. In the Project Graph, select UART6 Peripheral Library UART, and in the right Configuration
Options property sheet verify that the default Baud Rate is set to 115,200.

Figure 1-13. MCC UART Configuration



 TB3259
Creating a "Hello World" Application

 Technical Brief
© 2024 Microchip Technology Inc. and its subsidiaries

DS90003259B - 12

5. Configure the UART pins in the Pin Settings window. Click Project Graph and from the Plugins
drop-down item list, select Pin Configuration.

Figure 1-14. MCC Pin Configuration

6. The MCC Pin Configuration window will display these options: Pin Diagram, Pin Table, and Pin
Settings.

Figure 1-15. MCC Pin Settings

Note: According to schematic of the Curiosity PIC32MZ EF 2.0 Development Board, the PICkit™

On Board 4 (PKOB4) can be used as Virtual Com Port to have serial communication between the
PIC32MZ EF device and connected computer console, and for that RF2 (Pin #79) of the PIC32MZ
EF must be configured as U6TX.

7. Click on the Pin Settings tab, and then scroll down to the UART6 module. Enable the UART_TX
(U6TX) function on the RF2 (pin number 79) as shown in the following figure.
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Figure 1-16. UART Pin Settings

8. Users must configure the pin number 79 (pin ID RF2) by clicking the Pin Table tab.

Figure 1-17. UART Pin Table

Note: The demonstration application will use the UART peripheral libraries (PLIBs) for printing
messages on the serial terminal. Therefore, in the UART6 configuration, only the transmit pin is
configured and the receive pin is not configured.

1.3 Generating the Code
To generate the code, follow these steps:

1. In the left pane, click on the Resource Management [MCC] tab and then click Generate.
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Figure 1-18. MCC Generate Code

2. As code is generated, MPLAB Code Configurator will display the progress bar as shown in the
following figure.
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Figure 1-19. MCC Generating the Code

3. Navigate to the Project Resources tab to view the project tree structure, and it triggers these
actions in MCC:
a. Generates the code as per the user configurations.
b. Place the generated code and required Harmony framework files in the MPLAB Harmony

project directory, in this case: C:\Users\xxxx\HarmonyProjects\tech_brief\firmware\src (where,
xxxx means user ID).

c. Adds all generated codes and MPLAB Harmony framework files to the MPLAB Harmony
project, as shown in the following figure.
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Figure 1-20. MCC Generated Code

4. The generated code descriptions are as follows:
– definitions.h: Includes all header file definitions required for the project.

– initialization.c: Initializes all Harmony modules which are used in the application.

– interrupts.c: Contains the mapping of all interrupt vectors on the selected device.

– main.c: A function call to initialize the system which is present in this file. The user needs to
develop their application in this file.

– peripheral: All peripheral source codes are added in this folder.

Note: MCC provides an option to change the generated file name and if this option is not used,
the default option file name main.c is generated.
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Figure 1-21. MCC System Configuration

5. To build the project, click  (the Clean and Build icon) or click on
the drop-down menu icon to select Clean and Build Main Project .

6. Verify that the project builds successfully. At this point, the application code can be
implemented.

1.4 Developing and Running an Application
To develop and run an application, follow these steps:

1. Developing an application: For this demonstration application, add the highlighted codes (as
shown below) to the main.c file. This will send the “Hello World!” string to the console running on
the PC.
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The following code is provided for convenience:

uint8_t buffer[]= "Hello World!\r\n";

UART6_Write(&buffer[0], sizeof(buffer));

Figure 1-22. Developing Application

2. Connecting hardware: Connect a micro-USB cable between the DEBUG USB on the board and
the PC. This enables the programming of the microcontroller and provides a serial connection
with the console device.

Figure 1-23. Hardware Connection

Common USB 
Port for 

Debugging and 
UART Console
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3. Selecting the hardware tool and compiler: In the MPLAB X IDE Project Properties window
perform these actions.
a. Under the Categories section, select Conf: [pic32mz_ef_curiosity2].
b. In the right Configuration properties sheet, select the Connected Hardware Tool and

Compiler Toolchain.

Figure 1-24. Project Properties

4. Click Apply, and then click OK.
5. Setting up the serial console: Open the terminal application, Tera Term, on the PC and perform

the serial port setup. The following figure shows the Tera Term setup details.
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Figure 1-25. Serial Port Setup

6. Programming and running the application: To build and program the Curiosity PIC32MZ EF 2.0

Development Board by using the MPLAB X IDE, from the MPLAB X IDE toolbar click  (the
Make and Program icon} or click on the drop-down menu icon to select Make and Program
Device Main Project.

Figure 1-26. Make and Program

7. Observing the output: Observe the “Hello World!” string on the console. If the desired output is
not found on the console, press the Reset button on the Curiosity Development Board to reset
the device, and ensure that the UART message is communicated.
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Figure 1-27. Output



 TB3259
References

 Technical Brief
© 2024 Microchip Technology Inc. and its subsidiaries

DS90003259B - 22

2. References
• For additional information on MPLAB Harmony v3, go to the Microchip web site: https://

www.microchip.com/mplab/mplab-harmony
And
microchipdeveloper.com/harmony3:start

• For additional information about 32-bit Microcontroller collaterals and solutions, refer to:
ww1.microchip.com/downloads/aemDocuments/documents/MCU32/ProductDocuments/
ReferenceManuals/32-bit-Microcontroller-Collateral-and-Solutions-Reference-Guide-
DS70005534.pdf

• Detailed documentation on various MPLAB Harmony v3 components can be found in the “Doc”
folder of the corresponding repository.

• The Curiosity PIC32MZ EF 2.0 Development Board details are available at this location:
www.microchip.com/DevelopmentTools/ProductDetails/DM320209

https://www.microchip.com/mplab/mplab-harmony
https://www.microchip.com/mplab/mplab-harmony
https://microchipdeveloper.com/harmony3:start
http://ww1.microchip.com/downloads/aemDocuments/documents/MCU32/ProductDocuments/ReferenceManuals/32-bit-Microcontroller-Collateral-and-Solutions-Reference-Guide-DS70005534.pdf
http://ww1.microchip.com/downloads/aemDocuments/documents/MCU32/ProductDocuments/ReferenceManuals/32-bit-Microcontroller-Collateral-and-Solutions-Reference-Guide-DS70005534.pdf
http://ww1.microchip.com/downloads/aemDocuments/documents/MCU32/ProductDocuments/ReferenceManuals/32-bit-Microcontroller-Collateral-and-Solutions-Reference-Guide-DS70005534.pdf
https://www.microchip.com/DevelopmentTools/ProductDetails/DM320209
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3. Revision History
Revision B - January 2024
The following updates were performed for this revision:
• Terminology for the MHC was converted to MCC throughout the entire document
• Applied new updated images and texts for the MCC processes in the following sections:

– Creating an MPLAB Harmony v3-based Project
– Adding and Configuring the MPLAB Harmony Components
– Generating the Code
– Developing and Running an Application

Revision A - April 2020
This is the initial version of this document.
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The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to
make files and information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests,
online discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip
products. Subscribers will receive email notification whenever there are changes, updates, revisions
or errata related to a specified product family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are
also available to help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within

operating specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the

code protection features of Microchip product is strictly prohibited and may violate the Digital
Millennium Copyright Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its
code. Code protection does not mean that we are guaranteeing the product is “unbreakable”.
Code protection is constantly evolving. Microchip is committed to continuously improving the
code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including
to design, test, and integrate Microchip products with your application. Use of this information

https://www.microchip.com/
https://www.microchip.com/pcn
https://www.microchip.com/support
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in any other manner violates these terms. Information regarding device applications is provided
only for your convenience and may be superseded by updates. It is your responsibility to ensure
that your application meets with your specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at www.microchip.com/en-us/support/design-help/
client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR
ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO
MICROCHIP FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk,
and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any Microchip intellectual property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, Adaptec, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer,
LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST,
MOST logo, MPLAB, OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer,
QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer,
Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.

AgileSwitch, ClockWorks, The Embedded Control Solutions Company, EtherSynch, Flashtec, Hyper
Speed Control, HyperLight Load, Libero, motorBench, mTouch, Powermite 3, Precision Edge,
ProASIC, ProASIC Plus, ProASIC Plus logo, Quiet-Wire, SmartFusion, SyncWorld, TimeCesium,
TimeHub, TimePictra, TimeProvider, and ZL are registered trademarks of Microchip Technology
Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut,
Augmented Switching, BlueSky, BodyCom, Clockstudio, CodeGuard, CryptoAuthentication,
CryptoAutomotive, CryptoCompanion, CryptoController, dsPICDEM, dsPICDEM.net, Dynamic
Average Matching, DAM, ECAN, Espresso T1S, EtherGREEN, EyeOpen, GridTime, IdealBridge,
IGaT, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, IntelliMOS, Inter-Chip
Connectivity, JitterBlocker, Knob-on-Display, MarginLink, maxCrypto, maxView, memBrain, Mindi,
MiWi, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, mSiC, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, Power MOS IV, Power MOS 7, PowerSmart,
PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-ICE, Serial Quad I/O, simpleMAP,
SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher, SuperSwitcher II,
Switchtec, SynchroPHY, Total Endurance, Trusted Time, TSHARC, Turing, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered
trademarks of Microchip Technology Inc. in other countries.

https://www.microchip.com/en-us/support/design-help/client-support-services
https://www.microchip.com/en-us/support/design-help/client-support-services
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GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary
of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2024, Microchip Technology Incorporated and its subsidiaries. All Rights Reserved.
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Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit
www.microchip.com/quality.
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Tel: 886-2-2508-8600

Thailand - Bangkok

Tel: 66-2-694-1351

Vietnam - Ho Chi Minh

Tel: 84-28-5448-2100

Austria - Wels

Tel: 43-7242-2244-39

Fax: 43-7242-2244-393

Denmark - Copenhagen

Tel: 45-4485-5910

Fax: 45-4485-2829

Finland - Espoo

Tel: 358-9-4520-820

France - Paris

Tel: 33-1-69-53-63-20

Fax: 33-1-69-30-90-79

Germany - Garching

Tel: 49-8931-9700

Germany - Haan

Tel: 49-2129-3766400

Germany - Heilbronn

Tel: 49-7131-72400

Germany - Karlsruhe

Tel: 49-721-625370

Germany - Munich

Tel: 49-89-627-144-0

Fax: 49-89-627-144-44

Germany - Rosenheim

Tel: 49-8031-354-560

Israel - Ra’anana

Tel: 972-9-744-7705

Italy - Milan

Tel: 39-0331-742611

Fax: 39-0331-466781

Italy - Padova

Tel: 39-049-7625286

Netherlands - Drunen

Tel: 31-416-690399

Fax: 31-416-690340

Norway - Trondheim

Tel: 47-72884388

Poland - Warsaw

Tel: 48-22-3325737

Romania - Bucharest

Tel: 40-21-407-87-50

Spain - Madrid

Tel: 34-91-708-08-90

Fax: 34-91-708-08-91

Sweden - Gothenberg

Tel: 46-31-704-60-40

Sweden - Stockholm

Tel: 46-8-5090-4654

UK - Wokingham

Tel: 44-118-921-5800

Fax: 44-118-921-5820
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